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ada mata kuliah Komputer 1, Anda sudah mempelajari tentang program 

R. Bagaimana memperoleh program R dan bagaimana instalasinya 

sudah diperkenalkan. Kemudian, juga bagaimana menggunakan program R 

untuk analisis data statistik. Selain itu, Anda juga telah diperkenalkan bahwa 

pada program R disediakan lingkungan pemrograman yang memberi 

keleluasaan pengguna untuk mendefinisikan sendiri perintah yang 

diperlukan.   

Pada mata kuliah Komputer II ini, Anda akan diajak lebih jauh untuk 

memanfaatkan lingkungan pemrograman R untuk analisis data melalui 

pembuatan suatu fungsi.  Perintah-perintah R pada dasarnya merupakan suatu 

fungsi. Fungsi-fungsi yang telah disediakan oleh R, sebagian besar sudah 

cukup untuk memenuhi kebutuhan komputasi yang relatif sederhana.  Fungsi-

fungsi R tersebut disediakan oleh "package:stats", 

"package:graphics", "package:grDevices", 

"package:utils", "package:methods", dan 

"package:base".  Disamping package yang menyediakan objek berupa 

fungsi-fungsi,  R juga menyediakan objek data frame yang disediakan oleh 

"package:datasets". Ketujuh package tersebut secara otomatis dimuat oleh R 

saat dijalankan pertama kali. 

Sebagian besar fungsi-fungsi yang telah digunakan sebelumnya tersedia 

pada "package:base", "package:graphics", dan "package:stats".  Kode 

program dari suatu fungsi R dapat dilihat dengan mengetik fungsi tersebut 

pada console tanpa tanda kurung, misalnya, 

 

> var 

 

P 

PENDAHULUAN 
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Penulisan program dalam bahasa R pada dasarnya adalah membuat suatu 

fungsi, yang melibatkan suatu struktur pemrograman sehingga fungsi yang 

dibuat itu dapat bekerja sebagaimana yang dikehendaki.   

Pada Kegiatan Belajar 1 akan dipelajari dengan menciptakan suatu 

fungsi sendiri. Fungsi-fungsi ini diciptakan untuk memenuhi kebutuhan 

komputasi yang belum disediakan oleh package-package yang ada, atau ingin 

melakukan sedikit modifikasi terhadap fungsi-fungsi yang telah ada.  

Sebenarnya hal yang telah dipelajari sebelumnya sudah dapat dikategorikan 

sebagai kegiatan pemrograman. Tetapi, hal yang dilakukan itu masih bersifat 

interaktif, artinya setiap baris perintah yang ditulis akan segera mendapatkan 

respon oleh R.   

Pada Kegiatan Belajar 2 akan dibahas, pemakaian editor untuk penulisan 

program, dan kemudian sewaktu-waktu bila diperlukan, dapat dipanggil 

kembali. Untuk keperluan tersebut, pemakaian editor ini akan mempermudah 

pemberian perintah di R. 

Secara umum, setelah mempelajari Modul 1 ini, mahasiswa mampu 

menggunakan Tinn R dan editor R terpasang, untuk membuat fungsi-fungsi 

R yang sederhana. Adapun secara rinci, kemampuan yang diharapkan adalah: 

1. memahami cara-cara memberikan perintah di dalam R; 

2. membuat fungsi yang sederhana dengan bahasa R; 

3. memanfaatkan editor yang disediakan oleh program R. 
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Kegiatan Belajar 1 
 

Membuat Fungsi Sederhana 
 

 telah menyediakan fungsi yang banyak sekali seperti mean, median, 

rnorm dan sebagainya yang disebut dengan fungsi-fungsi terpasang.  

Fungsi-fungsi terpasang tersebut kebanyakan disediakan oleh package base, 

stats, graphics dan sebagainya.  Fungsi search() disediakan untuk 

melihat package-package yang telah dimuat (loaded) oleh R. Tersedia 

package-package lain yang dapat diunduh (download) secara cuma-cuma 

pada http://cran.r-project.org/. Package-package tersebut menyediakan 

fungsi-fungsi tambahan dan objek-objek lain seperti data sehingga 

menambah kemampuan komputasi R.  Kadang-kadang fungsi-fungsi yang 

telah disediakan tersebut belum juga memenuhi kebutuhan komputasi.  Oleh 

karena itu, R menyediakan fungsi dengan nama function untuk membuat 

suatu fungsi sendiri.  Secara umum, suatu fungsi dibangun dengan perintah 

berikut: 

 

> fungsi.br<-function(argumen1, argumen2, 

dst)perintah/ekspresi 

 

Dalam perintah tersebut fungsi.br merupakan nama fungsi yang kita 

buat.  Setelah fungsi function dituliskan, perintah atau ekspresi yang akan 

melakukan proses komputasi yang diharapkan dapat dilakukan oleh 

fungsi.br.  Apabila perintah atau ekspresi ini lebih dari satu dan 

membutuhkan lebih dari satu baris untuk menuliskan perintah-perintah 

tersebut, maka digunakan kurung kurawal “{“ dan “}” untuk melingkupi 

perintah-perintah dalam fungsi function tersebut.  Penulisannya secara 

umum adalah sebagai berikut: 

 

> fungsi.br<-function(argumen1, argumen2, dst){ 

+   perintah 1 / ekspresi 1 

+   perintah 2 / ekspresi 2 

   ..... 

+   perintah n / ekspresi n 

}     

R 

http://cran.r-project.org/
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Untuk menjalankan perintah fungsi.br, pada console diketikkan 

fungsi tersebut bersama argumen yang diperlukan, yaitu sebagai berikut: 

 

> fungsi.br(argumen1, argumen2, dst) 

 

Contoh berikut ini memberikan teladan dalam membuat fungsi sendiri 

yang sederhana. 

 

Contoh 1.1. 

Buatlah sebuah fungsi R untuk mengkonversi suhu dalam Celcius ke 

Fahrenheit. Kita mengetahui bahwa rumus konversi dari Celcius ke 

Fahrenheit adalah 

9
fahrenheit celcius 32

5
    

 

Berdasarkan rumus tersebut akan dibangun fungsi untuk mengkonversi 

Celcius ke Fahrenheit. Secara sederhana perintahnya adalah sebagai berikut: 

 

> fahrenheit<-function(celcius) 9/5 * celcius + 32 

 

Sekarang 20
o
C akan dikonversi ke dalam satuan Fahrenheit.  Fungsi 

fahrenheit dipanggil sebagai berikut: 

 

> fahrenheit(celcius=20) 

[1] 68 

 

Hasilnya adalah 68. Jadi 20
o
C sama dengan 68

o
C. 

Kadang-kadang nilai default pada fungsi yang dibuat sudah diberikan, 

misalnya pada fungsi konversi tersebut argumen celcius diberi nilai 

default 20.  Penulisan fungsinya sebagi berikut: 

 

> fahrenheit<-function(celcius=20) 9/5*celcius + 32 

 

Jika 20
o
C akan dikonversi kedalam Fahrenheit, cukup ditulis sebagai 

berikut: 
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> fahrenheit() # tidak diperlukan nilai argumen 

fungsi 

 

Hasil yang diberikan juga 68. Dalam perintah tersebut, 20 tidak 

dituliskan sebagai nilai argumen karena 20 merupakan nilai default dalam 

fungsi fahrenheit.   

Jika 5
o
C akan dikonversi kedalam Fahrenheit dan hasilnya disimpan 

pada objek (variabel) fah, perintahnya dituliskan sebagai berikut: 

 

> fah<-fahrenheit(celcius=5) 

 

Hasil konversinya diperoleh dengan memanggil objek fah, sebagai berikut: 

 

> fah 

[1] 41 

 

Kita dapat memberikan lebih dari satu nilai pada argumen celcius, 

misalkan nilai yang akan dikonversikan dari Celcius ke Fahrenheit adalah 5, 

25, 40, 72.  Perintahnya adalah sebagai berikut: 

 

> fahrenheit(c(5, 25, 40, 72)) 

[1]  41.0  77.0 104.0 161.6 

 

Hasil yang diperoleh adalah 5
o
C sama dengan 41

o
F, 25

o
C sama dengan 

77
o
C, 40

o
C sama dengan 104

o
F, dan 72

o
C sama dengan 161.6

o
F. 

Kita menggunakan fungsi c()untuk menyatakan bahwa lebih dari satu 

nilai yang diberikan pada suatu argumen, nilai argumennya berupa suatu 

vektor.  Penulisan nama argumen (celcius) pada perintah di atas bersifat 

opsional, karena argumennya hanya satu.  Sebagaimana juga telah pernah 

dibahas pada Modul 1 bahwa penulisan nama-nama argumen tidak 

diperlukan asal urutan-urutan dari argumen-argumen suatu fungsi 

diperhatikan/diikuti.   

 

Contoh 1.2. 

Buatlah fungsi untuk menghitung rata-rata, simpangan baku dan median 

dari suatu data univariat (berupa vektor numerik). Pada fungsi ini akan 
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digunakan fungsi-fungsi terpasang mean, sd, dan median untuk 

menghitung rata-rata, simpangan baku dan median suatu data. 

 

> statistik<-function(dat=1:10){ 

+  rataan<-mean(dat) 

+  simp<-sd(dat) 

+  med<-median(dat) 

+  c(Rata.rata=rataan, Simpangan.Baku=simp,  

 Median=med) 

+ } 

> statistik() 

     Rata.rata Simpangan.Baku         Median 

      5.500000       3.027650       5.500000 

 

Perhatikanlah disini akan digunakan nilai default 1, 2, 3, … , 10 sebagai 

data yang akan dihitung rata-rata, simpangan baku, dan mediannya.  Oleh 

karena rangkaian perintah pada fungsi ini memerlukan lebih dari satu baris, 

maka perintah-perintah itu dilingkupi dengan “{“dan “}”. 

Dengan menggunakan fungsi statistik, hitunglah rata-rata, simpangan 

baku, dan median dari vektor height pada data frame women. 

 

> with(women, statistik(height)) 

     Rata.rata Simpangan.Baku         Median 

     65.000000       4.472136      65.000000 

 

Kita menggunakan fungsi with untuk memanggil vektor height yang 

ada di dalam data frame women.  Kita juga dapat menggunakan fungsi 

attach terhadap objek women sebelumnya agar dapat menggunakan vektor 

height. Hasil yang sama juga dapat diperoleh dengan perintah berikut: 

 

> statistik(women$height) 

 

Jika ingin melihat argumen apa saja yang disediakan oleh suatu fungsi, 

dapat digunakan fungsi args, misalnya sebagai berikut: 

 

> args(statistik)# hasilnya di bawah ini 

function (dat = 1:10) 
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> args(fahrenheit)# hasilnya di bawah ini 

 function (celcius) 

 

 

 

 

 

 

 

1) Buatlah fungsi-fungsi R untuk menghitung luas suatu bidang datar: 

a) Lingkaran dengan jari-jari r,dengan nilai default r = 1. (R 

menyediakan konstanta  yaitu objek pi). 

b) Segi tiga dengan panjang alas a dan tinggi h, dengan nilai default a 

=1, h = 2. 

c) Bujur sangkar dengan panjang sisi x, dengan nilai default x = 1. 

d) Segi empat dengan lebar x dan panjang y. 

2) Pada Contoh 1.2 lakukanlah modifikasi terhadap fungsi statistik, yaitu 

dengan mengganti perintah c(Rata.rata=rataan, 

Simpangan.Baku= simp, Median=med) dengan 

list(Rata.rata=rataan, Simpangan.Baku=simp, 

Median=med).  Jalankanlah fungsi tersebut dan catat perbedaan 

hasilnya. (catatan: list biasanya digunakan bila class objek-objek 

yang dihasilkan berbeda) 

3) Buatlah sebuah fungsi untuk menghitung statistik-t dari dua sampel 

bebas, dengan ragam sama.  Rumus-rumus yang diperlukan adalah 

sebagai berikut: 

      1 2 1 2

1 2

;
1 1

p

x x
t

S
n n

 
 
  





   2 2

1 1 2 22

1 2

1 1
dan

2
p

n S n S
S

n n

 


 
 

Argumen-argumen yang diperlukan oleh fungsi tersebut adalah rata1 

(rata-rata sampel 1), rata2 (rata-rata sampel 2), n1 (ukuran sampel 1), 

n2 (ukuran sampel 2), beda (rata-rata populasi 1 -  rata-rata populasi 2), 

s1 (simpangan baku sampel 1), dan s2 (simpangan baku sampel 2).  

Keluaran yang ingin diperoleh dari fungsi ini adalah nilai t-hitung dan 

simpangan baku gabungannya.  Kedua keluaran itu diberi nama 

T.hitung dan Simpangan.gabungan. 

LATIHAN 

 

Untuk memperdalam pemahaman Anda mengenai materi di atas, 

kerjakanlah latihan berikut! 
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4) Jalankanlah fungsi pada soal nomor 3 yang Anda buat dengan memberi 

nilai untuk rata1 = 32, rata2 = 28, beda= 0, n1= 12, n2 = 

15, s1 = 2.1, dan s2 = 1.9. 

 

Petunjuk Jawaban Latihan 

 

1) Lihatlah kembali Contoh 1.1, kemudian sesuaikan programnya dengan 

rumus mencari luas bangun datar yang bersesuaian. 

2) Gantilah sintaks perintah c dengan list! 

3) Berikut langkah-langkah utamanya, Anda tinggal melakukan 

penyesuaian 

a) Definiskan nama function, misalkan, 

 .....<-function(rata1,rata2,n1,n2,beda,s1,s2) 

b) Hitung Sp 

c) Hitung t 

4) Panggil dengan cara misalkan 

.....(32,28, 0,12,15,2.1, 1.9.) 

 

 

 

 

Setiap perintah R merupakan fungsi. R menyediakan banyak sekali 

fungsi-fungsi terpasang dan sebagian disediakan oleh package-package 

yang dapat diunduh gratis. R juga memiliki kemampuan untuk membuat 

fungsi sesuai kebutuhan pengguna, yaitu dengan memanfaatkan fungsi 

function. 

 

 

 

 

 

1) Buatlah suatu fungsi untuk menghitung nilai y yang memenuhi 

persamaan garis lurus y mx c  , m, x dan c merupakan input dari 

fungsi. 

A. nilai.y ← function(m, x, c) y = mx + c 

B. nilai.y ← function(m, x, c) mx + c  

C. nilai.y ← function(m, x, c) m*x + c 

D. nilai.y ← function(m, x, c) y = m*x + c 

RANGKUMAN 

TES FORMATIF 1 

 

Pilihlah satu jawaban yang paling tepat! 
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2) Berdasarkan fungsi yang dibuat pada soal nomor 1, terkalah jawaban 

perintah berikut, bila dijalankan di R:  nilai.y(2:4, 3, 1)  

A. 7 13  

B. 7 10 13 

C. 7 

D. tidak ada jawabannya 

 

3) Buatlah sebuah fungsi untuk menghitung volume dan luas permukaan 

sebuah bola, dengan nilai default untuk diameter bola adalah 1. 

Diketahui bahwa volume dan luas permukaan bola diperoleh dengan 

rumus berikut: 

 
34

Volume jejari
3

    dan  
2

Luas 4 jejari    

A. Bola ← function(diameter) { 

volume ← 4/3*π*(1/2*diameter)^3 

luas ← 4*π*(1/2*diameter)^2 

return(c(volume, luas)) 

} 

B. Bola ← function(diameter=1) {  

volume ← 4/3*π*(1/2*diameter)^3 

   luas ← 4*π*(1/2*diameter)^2 

   return(c(volume, luas)) 

} 

C. Bola ← function(diameter=1) {  

volume ← 4/3*pi*(1/2*diameter)^3 

   luas ← 4*pi*(1/2*diameter)^2 

   return(Volume=volume, Luas=luas) 

} 

D. Bola ← function(diameter=1) {  

volume ← 4/3*pi*(1/2*diameter)^3 

   luas ← 4*pi*(1/2*diameter)^2 

   return(list(Volume=volume, Luas=luas)) 

} 

 

4) Tulislah perintah untuk menghitung volume dan luas permukaan bola 

dengan jejari sama dengan 1/2.  Gunakan fungsi yang benar pada soal 

nomor 3. 

A. Bola()  

B. Bola(1/2)  

C. Bola(diameter=1/2)  

D. Bola(jejari=1/2)  
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5) Tulislah perintah untuk menghitung volume dan luas permukaan bola 

menggunakan fungsi yang benar pada soal nomor 3, jika ingin 

melakukan simulasi terhadap berbagai diameter bola yaitu 5, 10, 15, 20, 

25 … 100. 

A. Bola(5:100)  

B. Bola(c(5, 10, 15, 20, 25, …, 100))  

C. Bola(seq(5, 100, 5))  

D. Bola(rep(5, 100))  

 

6) Bila seandainya hasil fungsi Bola pada soal nomor 3 disimpan pada 

objek x maka perintah untuk mendapatkan nilai-nilai hasil perhitungan 

untuk luas permukaan bola saja adalah .... 

A. x$Luas   

B. x$luas   

C. x[1]  

D. x[[1]]  

 

7) Fungsi R untuk mendapatkan argumen-argumen apa saja yang dimiliki 

oleh suatu fungsi adalah .... 

A. Argument 

B. Args 

C. args 

D. ls() 

 

8) Tuliskanlah perintah R untuk menampilkan grafik tebaran Volume vs 

Luas permukaan bola, yang dihasilkan oleh jawaban yang benar pada 

pertanyaan nomor 5.   

A. plot(Bola(seq(5, 100, 5))$Volume), 

 Bola(seq(5, 100, 5))$Luas)) 

B. attach(Bola()) 

 plot(Volume, Luas) 

C. plot(Bola(seq(5, 100, 5)))  

D. plot(Bola(seq(5, 100, 5))$Volume, 
 Bola(seq(5, 100, 5))$Luas) 
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9) Tuliskanlah perintah R untuk mendapatkan rasio volume bola terhadap 

luas permukaannya. Nilai diameter yang digunakan adalah nilai 

simulasi seperti pada soal nomor 5 dan objek x digunakan untuk 

menyimpan hasil perhitungan fungsi Bola. 

A. x ← Bola(seq(5, 100, 5)) 

 with(x, ratio(Volume, Luas)) 

B. x ← Bola(seq(5, 100, 5)); with(x, 

Volume/Luas) 

C. x← Bola(seq(5, 100, 5)); with(x, 

x(Volume/Luas))  

D. x ← Bola(seq(5, 100, 5)), with(x, 

Volume/Luas) 

  

10) Berdasarkan soal nomor 1 tuliskanlah perintah R untuk mensimulasi 

nilai y dengan nilai-nilai input x dari -2 sampai 2 dengan kenaikan 0.5 

unit, m diberi nilai 2 dan c sama dengan -3. 

A. nilai.y(x=seq(-2, 2, 0.5), m=2, c=-3)  

B. nilai.y(seq(-2, 2, 0.5), 2, -3)   

C. nilai.y(x=c(-2, 2, 0.5), m=2, c=-3)  

D. nilai.y(x=(-2, 2, 0.5), m=2, c=-3) 

 

Cocokkanlah jawaban Anda dengan Kunci Jawaban Tes Formatif 1 yang 

terdapat di bagian akhir modul ini. Hitunglah jawaban yang benar. 

Kemudian, gunakan rumus berikut untuk mengetahui tingkat penguasaan 

Anda terhadap materi Kegiatan Belajar 1. 

 

 

 

 

 

              Arti tingkat penguasaan: 90 - 100% = baik sekali 

                                          80 -  89%  = baik 

                                          70 -  79%  = cukup 

                                               < 70%  = kurang 

 

Apabila mencapai tingkat penguasaan 80% atau lebih, Anda dapat 

meneruskan dengan Kegiatan Belajar 2. Bagus! Jika masih di bawah 80%, 

Anda harus mengulangi materi Kegiatan Belajar 1, terutama bagian yang 

belum dikuasai. 

Tingkat penguasaan = 
Jumlah Jawaban yang Benar

100%
Jumlah Soal

  
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Kegiatan Belajar 2 
 

Editor R dan Tinn-R 
 

angkaian perintah R yang berupa suatu fungsi dapat diketik langsung 

pada console R tetapi apabila perintah-perintah tersebut merupakan 

suatu rangkaian yang amat panjang maka akan lebih baik diketik terlebih 

dahulu pada suatu editor. Antar Muka Graphis atau Graphical User Interface 

(GUI) standar R pada menunya sudah menyediakan pilihan untuk 

menampilkan editor. Editor tersebut digunakan untuk menuliskan kode 

perintah (script) R. Tinn-R merupakan editor alternatif yang disarankan untuk 

digunakan, karena kemampuannya yang dapat berinteraksi dengan R.  Editor 

ini dari namanya saja dapat diterka memang dirancang untuk R, walaupun 

demikian Tinn-R juga dapat digunakan untuk sebagian besar bahasa 

pemrograman lain. 

 

A. EDITOR R 

 

Pada dasarnya R merupakan suatu interpreter yang akan merespon setiap 

perintah secara baris demi baris sehingga memberikan kemampuan interaktif 

dengan pengguna. Pada tingkat yang lebih lanjut biasanya ingin disimpan 

kode-kode perintah R yang dibuat, untuk digunakan kemudian. Perintah-

perintah yang sudah diketik pada suatu editor disimpan dalam file dengan 

ekstensi R atau r (misalnya nama_file.R atau nama_file.r). GUI standar R 

pada menunya menyediakan fasilitas editor tersebut.  Pada menu bar R GUI 

klik menu File dan kemudian pilih New_script untuk menampilkan editor, 

yang siap untuk diketikkan perintah-perintah R.  

Gambar 1.1 memperlihatkan menu File dan sub-sub menunya dan 

Gambar 1.2 memperlihatkan Editor R dan menu yang tersedia untuk Editor 

tersebut. Untuk menyimpan perintah-perintah R yang Anda ketik pada editor, 

pilih menu File kemudian pilih Save atau Save_as.  Biasanya pilihan Save_as 

digunakan ketika pertama kali menyimpan suatu file. Untuk menjalankan 

perintah-perintah yang telah disimpan dalam suatu file, langkah-langkahnya 

adalah klik menu File, kemudian pilih Source_R_code dan muncul Jendela 

Folder. Cari dan temukan folder / file dimana file perintah-perintah R 

disimpan, kemudian klik tombol Open.   

R 
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Kita dapat juga memanggil semua objek (tentunya termasuk fungsi) 

dengan menggunakan perintah/fungsi source.  Contoh 2.1 akan  

memperagakan bagaimana memasukkan perintah R kedalam editor, 

kemudian menyimpan dan memanggilnya kembali dengan menggunakan 

fungsi source. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 1.1 
Menu File dengan sub-sub menunya, sub menu New_script untuk 

menampilkan Editor kosong. 
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Gambar 1.2 
Editor R dan menu yang tersedia untuk Editor tersebut. 

 

Contoh 2.1. 

1. Pada Kegiatan Belajar 1 Contoh 1.1 sudah dibuat fungsi fahrenheit 

yang mengkonversi suhu dalam unit Celcius ke unit Fahrenheit, dan 

fungsi statistik untuk menghitung rata-rata, simpangan baku dan 

median.  Ketikkanlah kedua fungsi tersebut pada Editor R, simpan 

dengan nama “FahStat.R” (tanda petik dua tidak perlu disertakan).  Pada 

versi 2.8.1 ekstensi R tidak diberikan secara otomatis ketika disimpan 

dalam format R, sehingga harus dituliskan dengan lengkap. 

a. Buatlah langkah-langkah untuk menghasilkan file FahStat.R tersebut 

b. Panggil file FahStat.R dan perlihatkan bahwa fungsi fahrenheit 

dan statistik telah dimuat kedalam R. 

c. Gunakan fungsi fahrenheit untuk mengkonversi suhu 10, 15, 

20, 25 dan 30
0
C ke dalam

0
F. 

d. Gunakan fungsi statistik yang telah dibuat untuk menghitung 

Rata-rata, Simpangan Baku dan Median dari data weight yang ada 

di dalam data frame women. 

 

Jawaban: 

1. Langkah-langkahnya adalah sebagai berikut: 

a. Pada GUI (Antar Muka Graphis) R klik menu File kemudian pilih 

New_sript. Muncul Editor kosong, ketikan kode berikut ini pada Editor 

tersebut, 

 fahrenheit<-function(celcius) 9/5*celcius + 32 

 statistik<-function(dat=1:10){ 

 rataan<-mean(dat) 

Editor R 

Menu editor 
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 simp<-sd(dat) 

 med<-median(dat) 

 c(Rata.rata=rataan, Simpangan.Baku=simp,  

Median=med) 

} 

 

Hasilnya tampak seperti Gambar 1.3 berikut ini 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 1.3 
Fungsi fahrenheit dan statistik diketikkan pada Editor R 

 

b. Pada menu Editor pilih dan klik menu File dan kemudian klik sub menu 

Save_as.  Gambar 1.2 memperlihatkan menu Editor dengan menu File 

terpilih dan sub-sub  menunya. Menu R GUI secara otomatis akan 

diganti oleh menu Editor, apabila Editor R muncul atau aktif.  

Sebaliknya apabila R GUI yang aktif maka menu R yang akan tampil, ini 

akan sedikit membingungkan bagi pemula karena kedua menu tersebut 

ada pada posisi bar yang sama. 

 

c. Setelah submenu Save_as dipilih, Jendela Folder akan muncul.  Tujulah 

dan pilihlah drive atau folder tempat Anda akan menyimpan file 

FahStat.R. Misalkan Anda menyimpannya di drive D: dan folder 

MyRDoc (Anda bisa saja menyimpannya pada drive dan folder yang 

berbeda). Setelah folder MyRDoc terpilih ketik “FahStat.R” (tanpa tanda 

“ dan “) kemudian klik tombol Save. Gambar 1.4 memperlihatkan 

Jendela Folder dengan folder MyRDoc sudah terbuka dan tombol Save 
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siap diklik. Jalur (path) tempat file FahStat.R adalah 

“D:/MyRDoc/FahStat.R”. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 1.4 
Jendela Folder MyRDoc tempat file “FahStat.R” disimpan 

 

d. Klik tombol Save.  Sekarang Anda sudah memiliki file FahStat.R dengan 

alamat jalur di “D:/MyRDoc/FahStat.R” (Bila drive atau folder Anda 

berbeda, maka alamat jalurnya juga berbeda). 

Demikianlah ada empat langkah untuk menghasilkan file FahStat.R. 

 

2. Untuk memanggil / memuat file FahStat.R pada console R, ketik 

perintah berikut dan jangan lupa alamat jalur harus diapit oleh tanda “ 

dan “. 

 

> source(file="D:/MyRDoc/FahStat.R") 

 

Alamat jalur harus diapit oleh tanda petik dua, karena alamat jalur bukan 

merupakan objek R.Jika Anda lupa alamat jalur tempat file FahStat.R 

berada, perintah berikut sebaiknya digunakan. 

 

> source(file=file.choose()) 

 

../../../../../MyRDoc/FahStat.R
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Perintah terakhir ini akan memunculkan Jendela Folder, cari dan tujulah 

drive atau folder tempat file Anda berada. Setelah file FahStat.R 

dipanggil, cobalah ketikkan perintah ls() untuk melihat semua objek 

pada memori R. 

> ls() 

[1] "fahrenheit" "statistik" 

 

Dapat dilihat bahwa sudah ada dua objek (berupa fungsi) yaitu 

fahrenheit dan statistik, yang siap untuk digunakan. 

 

4. Untuk mengkonversi suhu 10, 15, 20, 25 dan 30
0
C ke dalam

0
F 

perintahnya adalah: 

 

> fahrenheit(seq(10, 30, 5)) 

[1] 50 59 68 77 86 

 

Perhatikanlah disini digunakan fungsi seq(from=10,to=30, 

by=5) untuk menghasilkan vektor numerik 10, 15, 20, 25 dan 30. 

 

5. Pada console ketiklah fungsi statistik berikut, untuk menghasilkan 

Rata-rata, Simpangan Baku dan Median dari data weight. 

 

> with(women, statistik(weight)) 

Rata.rata Simpangan.Baku         Median 

136.73333       15.49869      135.00000 

 

B. TINN-R 

 

Tinn-R tidak sekadar editor tetapi juga dirancang sebagai antarmuka 

graphis untuk bahasa R dan lingkungannya. Tinn-R dirancang untuk bekerja 

dibawah sistem operasi Windows. Situs web resmi Tinn-R ada pada alamat 

http://www.sciviews.org/Tinn-R/ sedangkan untuk 

mengunduhnya sudah disediakan di http://sourceforge.net/ 

projects/tinn-r. Tinn-R dapat diunduh dan digunakan gratis.  Anda 

disarankan untuk mengunduh file binary Tinn-R tersebut, sebelum 

melanjutkan membaca tulisan ini. Tulisan ini dibuat berdasarkan versi 

2.2.0.2. 

http://www.sciviews.org/Tinn-R/
http://sourceforge.net/%20projects/tinn-r
http://sourceforge.net/%20projects/tinn-r
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Tidak seperti halnya Editor R atau yang lain, Tinn-R akan memberikan 

warna yang berbeda pada setiap fungsi/perintah R dan memberikan tanda 

(biasanya berwarna merah) terhadap setiap pasangan tanda kurung “(“ dan 

“)” atau “{“ dan “}”. Hal ini akan menghindarkan dari kelupaan dalam 

memberikan pasangan terhadap setiap tanda-tanda kurung tersebut.  Hal ini 

akan sangat membantu terutama bila bekerja dengan banyak sekali pasangan 

tanda-tanda kurung.  Anda akan dapat merasakannya sendiri nanti bila 

menggunakan Tinn-R.   

Tinn-R menyediakan sebuah menu untuk membuka dan menutup R GUI, 

sehingga Jendela Tinn-R dan R dapat diletakkan berdampingan.  Posisi 

defaultnya adalah sebelah atas untuk Jendela Tinn-R dan bagian bawah 

adalah Jendela R.  Posisi tersebut dapat diubah sesuai dengan keinginan kita.  

Gambar 1.5 memperlihatkan Jendela Tinn-R dan R pada layar monitor 

komputer. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 1.5 
Tampilan Jendela Tinn-R (atas) dan Jendela R GUI (bawah) 

 

Setelah Anda berhasil mengunduh file binary dari Tinn-R (berekstensi 

.exe), Anda siap untuk menginstalnya dibawah sistem operasi Windows.  
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Cara intalasinya adalah umum, sebagaimana Anda menginstal software-

software lain dibawah sistem operasi Windows. Anda hanya mengikuti 

langkah-langkah interaktif yang diberikan.  Apabila  Anda berhasil dalam 

langkah instalasi ini, maka pada dekstop komputer Anda akan tersedia 

tombol Tinn-R dengan icon berbentuk pensil (lihat Gambar 1.6). 

 
 
 
 
 

Gambar 1.6 
Icon Tinn-R 

 

Klik icon tersebut atau dapat juga melalui menu pada tombol “start” 

kemudian pilih “All Programs” dan seterusnya, maka Jendela Tinn-R akan 

muncul pada layar komputer Anda.  Menu-menu Tinn-R dapat dilihat pada 

Gambar 1.7.  Pada Gambar tersebut juga diperlihatkan sub menu dan tombol 

untuk melakukan koneksi ke R GUI.  Editor kosong (baru) dapat diberikan 

oleh R dengan mengklik menu File→New atau menekan tombol menu 

seperti diperlihatkan oleh Gambar 1.7 atau tekan tombol Ctrl+N. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 1.7 
Jendela Tinn-R beserta menu-menunya 

 

Langkah-langkah untuk mengkoneksi Tinn-R dengan R GUI: 

1. Pilih dan klik menu R pada menu bar Tinn-R; 

2. Pilih dan klik sub menu Start/close and connections; 

3. Pilih dan klik sub-sub menu Rgui (start). 
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Cara yang lebih cepat adalah dengan klik tombol dengan icon huruf R 

(lihat Gambar 1.7).  Hasilnya adalah di bawah Jendela Tinn-R akan muncul 

Jendela R GUI, seperti nampak pada Gambar 1.5.  Berikut ini adalah 

langkah-langkah bagaimana memindahkan perintah-perintah yang telah 

dituliskan pada Editor Tinn-R ke Jendela R.  Anda diasumsikan telah 

membuka Jendela Editor Tinn-R dan telah terhubung dengan R GUI (layar 

akan tampak seperti Gambar 1.5).  Kita akan menggunakan file FahStat.R 

untuk  mendemonstrasikan langkah-langkah tersebut. 

1. Aktifkan Jendela Tinn-R dengan mengklik bidang kosong pada editornya; 

2. Pilih menu File lalu sub menu Open, kemudian muncul Jendela Folder; 

3. Pilih dan tujulah folder dimana file FahStat.R berada, jika sudah 

ditemukan klik tombol Open.  Pada editor Tinn-R akan tercetak fungsi 

fahrenheit dan statistik, yang sebelumnya telah diketik di 

Editor R.  Gambar 1.8 memperlihatkan hal tersebut. 

 

 
 

Gambar 1.8 

Kode-kode R untuk membuat fungsi fahrenheit dan statisitik tercetak 
pada editor Tinn-R 

 

Warna kuning pada baris pertama menunjukkan bahwa baris tersebut 

adalah baris aktif.  Untuk mengaktifkan suatu baris, cukup dengan mengklik 

baris yang diinginkan.  Cobalah Anda lakukan hal tersebut sehingga menjadi 

lebih jelas.  Pada Gambar 1.8 juga nampak bahwa tombol-tombol untuk 

mengirim baris-baris perintah menjadi aktif seketika, bila pada editor telah 
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tercetak kode-kode R.  Tombol paling kiri (R send: line) ( ) digunakan 

untuk mengirim perintah R ke R GUI, secara baris demi baris. 

1. Tombol berikutnya (Editor: current line to top) ( ) digunakan untuk 

menggulung layar editor sehingga baris aktif menjadi berada pada posisi 

paling atas.   

2. Tombol berikutnya (R send: lines to end page (echo=TRUE)) ( ) 

mengirim baris perintah ke R GUI dari posisi baris aktif saat ini sampai 

akhir halaman.   

3. Tombol kedua dari kanan (R send: cursor to beginning line) ( ) 

digunakan untuk mengirim perintah R dari posisi kursor saat ini sampai 

awal baris.   

4. Tombol paling kanan (R send: cursor to end line) ( ) digunakan 

untuk mengirim baris perintah dari kursor saat ini sampai akhir baris.   

 

Cobalah letakkan pointer tetikus (mouse) Anda pada tombol-tombol 

tersebut (Jendela Tinn-R harus dalam kondisi aktif) maka akan muncul 

keterangan dari tombol-tombol itu.  Langkah-langkah berikut memperagakan 

proses pengiriman baris perintah dari editor Tinn-R ke R GUI. 

1. Klik pointer pada baris dimana tercetak perintah untuk membuat fungsi 

fahrenheit.  Garis kuning akan menandai baris tersebut sebagai baris 

aktif (nampak seperti Gambar 1.8) 

2. Klik tombol R send: line, maka perintah pada baris tersebut akan segera 

terkirim ke R GUI yang ada di bawahnya.  Baris kuning otomatis 

berpindah ke baris berikutnya yang berisi perintah R, dalam hal ini baris 

yang berisi perintah untuk membuat fungsi statistik.  Baris kosong 

akan diloncati. 

3. Klik kembali tombol R send: line, demikian seterusnya hingga semua 

perintah dipindahkan ke R GUI. 

 

Langkah-langkah di atas sangat baik digunakan untuk memeriksa 

perintah R baris demi baris, untuk menelusuri logika program maupun 

menemukan adanya kesalahan (error), seperti kesalahan sintaks.  Cobalah hal 

yang serupa seperti langkah-langkah di atas, tetapi dengan menggunakan 

tombol-tombol lainnya. Jika Anda ingin mengenal lebih dalam kemampuan 

Tinn-R, bacalah user guide yang disediakannya. Untuk menampilkan user 
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guide tersebut, pilih menu Help pada menu bar Tinn-R, lalu klik submenu 

User guide dan terakhir pilih sub-sub menu Html.  Ringkasnya klik berturut-

turut Help→ User guide → Html, maka akan muncul “Tinn-R User Guide” 

dalam format html. 

 

 

 

 

 

 

 

(Catatan: Latihan ini hanya dapat Anda kerjakan dengan menggunakan 

komputer personal yang telah terpasang program R dengan versi minimal 

2.8.1 dan program Tinn-R versi minimal 2.2.0.2.) 

 

1) Tambahkan pada editor Tinn-R sebuah program R untuk menghitung 

statistik t, seperti di Latihan nomor 3 pada Kegiatan Belajar 1.  

Programmya adalah sebagai berikut: 

 

statistik.t<-function(rata1, rata2, beda, s1, 

s2, n1, n2){ 

var.p<-((n1-1)*s1^2 + (n2-1)*s2^2)/(n1+n2-2) 

Sp<-sqrt(var.p) 

t.hit<-((rata1-rata2)-beda)/Sp*sqrt(1/n1 + 1/n2) 

list(T.hitung = t.hit, Simpangan.gabungan=Sp) 

} 

 

a) Salinlah program di atas dengan cermat ke editor Tinn-R.   

b) Periksa apakah ada kesalahan sintaks. Bila ada kesalahan, tentukan 

kesalahan itu ada pada baris berapa dan perbaiki kesalahannya. 

c) Pelajari logika program di atas dengan mengirim perintah-perintah 

R tersebut, baris demi baris, ke R GUI. 

d) Simpanlah program di atas dengan nama file Stat.R pada folder 

pilihan Anda. (catatan: Pada menu bar Tinn-R, pilih menu File 

kemudian klik sub menu Save as, jangan lupa tentukan tipe filenya 

R atau R complex) 

e) Tambahkan perintah di bawah ini, kemudian kirim ke R GUI. 

LATIHAN 

 

Untuk memperdalam pemahaman Anda mengenai materi di atas, 

kerjakanlah latihan berikut! 
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statistik.t(rata1=32, rata2=28, beda=0, 

s1=2.1, s2=1.9,n1=12, n2=15) 

f) Apakah hasilnya benar seperti yang diharapkan?Bila diperlukan 

Anda dapat membandingkannya dengan perhitungan manual. 

g) Keluarlah dari Tinn-R dan R GUI pasangannya. Jalankanlah 

program R, sehingga muncul R GUI yang standar. Panggilah file 

Stat.R dan periksa apakah fungsi statistik.t sudah tersedia.  

Kemudian ketikkan kembali perintah seperti nomor e) di atas pada 

console R.  Periksalah hasilnya. 

 

2) Buatlah program R untuk menjawab pertanyaan-pertanyaan Latihan 1 

Kegiatan Belajar 1 menggunakan Editor R. Simpan fungsi-fungsi yang 

telah Anda buat, kemudian jalankan fungsi-fungsi tersebut pada console 

R. 

 

Petunjuk Jawaban Latihan 

 

1) Lakukan seperti pada Gambar 2.8, ketikkan fungsi statistik.t pada 

editor Tinn R. 

2) Ketikkan fungsi-fungsi Anda sebagai jawaban pertanyaan-pertanyaan 

Latihan 1 Kegiatan Belajar 1 pada Editor Tinn R ! 

 

 

 

 

Editor R dan Tinn-R digunakan untuk menuliskan perintah-perintah 

R yang kemudian disimpan dalam suatu file berekstensi R sehingga 

dapat digunakan kemudian jika diperlukan.  Tinn-R memiliki kelebihan 

dari pada editor-editor lain, seperti memberikan warna-warna berbeda 

pada kebanyakan kosa-kosa kata R yang dikenalnya.  Jadi, dapat 

meminimalkan terjadinya kesalahan sintaks.  Tinn-R juga dapat 

digunakan untuk memeriksa logika pemrograman dan kesalahan-

kesalahan sintaks, yaitu dengan menjalankan perintah-perintah R baris 

demi baris. 

 

 

 

 

RANGKUMAN 



1.24 Komputer II   

 

 

 

 

1) Editor kosong dapat diberikan oleh R GUI melalui menu File, dengan 

memilih submenu berikut .... 

A. Open script 

B. Open editor 

C. New script 

D. New editor 

 

2) Menu berikut tidak tersedia dalam Editor R .... 

A. File 

B. Help 

C. Edit 

D. View 

 

3) File “Stat.R” tersedia di folder “MyDoc” dan driver “C:”. Perintah 

berikut adalah memanggil file tersebut melalui console R. 

A. source(“C:/MyDoc/Stat.R”) 

B. source(file=C:/MyDoc/Stat.R) 

C. source(file=”C:/MyDoc/Stat”)  

D. source(C:/MyDoc/Stat.R) 

 

4) Perintah berikut ini dimasukkan ke editor Tinn-R 
Luas.segi.tiga<-Function(diameter) 

0.5*diameter)^2 * pi 

 Kemudian baris perintah tersebut dikirim ke R GUI dengan menekan 

tombol R send: line. Ternyata muncul pesan kesalahan. Terkalah apakah 

yang menyebabkan munculnya pesan kesalahan tersebut? 

A. Penulisan nama fungsi Luas.segi.tiga 

B. Penulisan fungsi Function 

C. Objek pi tidak dikenal 

D. Penulisan ekspresi (0.5*diameter)^2 

 

5) Untuk memunculkan nomor urut pada editor Tinn-R, maka rangkaian 

menu dan sub menu berikut dipilih (klik), yaitu .... 

A. View→Line numbers (show/hide) 

B. File→ New 

C. Tools → Count 

D. View → Special characters (show/hide) 

TES FORMATIF 2 

 

Pilihlah satu jawaban yang paling tepat! 
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6) Sintaks berikut ini oleh Tinn-R akan diberi warna khusus (highlight) 

karena dikenal sebagai sintaks R, kecuali .... 

A. list  

B. matriks 

C. c 

D. seq 

 

7) Editor kosong pada Tinn-R, diperoleh dengan cara .... 

A. File→ Open 

B. Ctrl + F8 

C. Ctrl + N 

D. Klik tombol R send: line 

 

8) Tipe file berikut dapat dibaca oleh Editor R maupun Tinn-R, kecuali .... 

A. R 

B. txt 

C. Rhistory 

D. doc 

 

9) Untuk mengaktifkan suatu baris pada editor Tinn-R adalah .... 

A. Klik baris yang ingin diaktifkan 

B. Klik baris kosong 

C. Klik Insert → Latex 

D. Klik tombol R send: line 

 

10) Ketika suatu file dengan tipe R berhasil dipanggil oleh fungsi source, 

kita belum mengetahui objek-objek R apa saja yang telah dimuatkan ke 

lingkungan R.  Fungsi R untuk melihat apakah suatu objek R telah 

tersedia pada memori, sehingga dapat digunakan, adalah .... 

A. list() 

B. data() 

C. ls() 

D. rm(list=ls()) 
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Cocokkanlah jawaban Anda dengan Kunci Jawaban Tes Formatif 2 yang 

terdapat di bagian akhir modul ini. Hitunglah jawaban yang benar. 

Kemudian, gunakan rumus berikut untuk mengetahui tingkat penguasaan 

Anda terhadap materi Kegiatan Belajar 2. 

 

 

 

 

 

              Arti tingkat penguasaan: 90 - 100% = baik sekali 

                                          80 -  89%  = baik 

                                          70 -  79%  = cukup 

                                               < 70%  = kurang 

 

Apabila mencapai tingkat penguasaan 80% atau lebih, Anda dapat 

meneruskan dengan modul selanjutnya. Bagus! Jika masih di bawah 80%, 

Anda harus mengulangi materi Kegiatan Belajar 2, terutama bagian yang 

belum dikuasai. 

 

 

Tingkat penguasaan = 
Jumlah Jawaban yang Benar

100%
Jumlah Soal

  
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Kunci Jawaban Tes Formatif  
 

Tes Formatif 1 

1) C 

2) B 

3) D 

4) A 

5) C 

6) A 

7) C 

8) D 

9) B 

10) A 

Tes Formatif 2 

1) C 

2) D 

3) A 

4) B 

5) A 

6) B 

7) C 

8) D 

9) A 

10) C 
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